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U.S. Payroll Tax Tables—June 2014 Updates
Government-Mandated Payroll Tax Changes
As a result of legislative changes, the payroll tax tables changed for the following jurisdictions, effective April 1, 2014:
l

Wisconsin
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Enhancements in Version 19.3
You will find the following new features and enhancements in Sage 100 Contractor Version 19.3.

Integration with Sage Payment Solutions
Sage 100 Contractor now integrates seamlessly with Sage Payment Solutions.
Using Sage Payment Solutions with Sage 100 Contractor saves you time, helps you get paid faster, and eliminates the
need to enter payment information twice. Simply enter your customer's card payment details once in Sage 100 Contractor,
and the payment will be processed in Sage 100 Contractor and Sage Payment Solutions, in one easy step.
With the integration between Sage 100 Contractor and Sage Payment Solutions, you can process credit card transactions
without storing your customers’ sensitive card information in your database. Sage Exchange transmits credit card details
through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting you
from exposure to non-compliance penalties and credit card fraud.
NOTE: In the U.S. edition, you can also process ACH checks electronically through Sage Payment Solutions, while
protecting your customers' banking information.
In addition to providing integrated payment processing, Sage Payment Solutions also offers gift and loyalty card programs,
merchant cash advances and loans, non-profit and healthcare payment solutions, and more.
To learn more about Sage Payment Solutions, visit http://na.sage.com/us/sage-payment-solutions.

Related changes in Sage 100 Contractor windows
We have updated several Sage 100 Contractor windows to support electronic receipt processing.

7-2 Company Information
We have added new options and added a tab in the 7-2 Company Information window:
l

You use the new Electronics Receipts Setup tab to specify your merchant ID and merchant key. Sage sends you
these credentials when you purchase a Sage Payment Solutions account.
This tab contains additional fields that determine how Sage 100 Contractor interacts with Sage Payment Solutions:
l

Posting Cash Account. You enter the ledger account for the bank account connected to your Merchant ID.

l

Allow client credit card and bank account information to be securely stored in the Sage Exchange
Vault in the U.S. Edition.

l

Allow client credit card information to be securely stored in the Sage Exchange Vault in the
Canadian Edition.

Storing sensitive client information in the Sage Exchange Vault allows you to reuse this information in electronic
receipt transactions without storing it in your company database. Sage Exchange uses the last credit card (or bank
account) number used for the client, or you can enter a different number when you process an electronic receipt.
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NOTE: If you select the company option to store client information in the vault, you can always override the
option for individual customers in the client record, if necessary.

3-6 Receivable Clients
We have added a new option, renamed some options, and renamed a tab in 3-6 Receivable Clients window:
l

The Payment and Billing tab is now called Billing and Payment.

l

A new option appears on the Billing and Payment tab that lets you override the company option for storing client
information.
If you use the U.S. edition, you can select Do not use the Sage Exchange Vault to store credit card and bank
account information.
If you use the Canadian edition, you can select Do not use the Sage Exchange Vault to store credit card
information.

l

Fields that used to be labeled for credit card information in older versions have been renamed Reference 1,
Reference 2, Reference 3, and Reference Date.
IMPORTANT: If you have been using these fields to store credit card information, we strongly recommend
that you remove that information from these fields.

New 3-3-2 Electronic Receipts
You use the new 3-3-2 Electronic Receipts window to process credit card receipts electronically, or to post a receipt
manually that was entered through a third-party website. There is also a corresponding new 3-3-2 Electronic Receipts
report.
NOTE: In the U.S. edition, you also use this window to process ACH checks electronically.
IMPORTANT: Before you can process receipts electronically, you need to set up a merchant account with Sage
Payment Solutions. Then, you must enter your merchant ID, merchant key, and bank account number in the 7-2
Company Information window.
The 3-3-2 Electronic Receipts window is very similar to the 3-3-1 Cash Receipts window, with a few notable differences:
l

You process an electronic receipt for one client at a time. Therefore:
l

You need to enter only the Client number in the transaction header.

l

You display invoices for the selected client in the grid.
Alternatively, you can enter an invoice number and let Sage 100 Contractor fill in the client information for
you.

l

If you selected the company option to store client information in the Sage Exchange Vault, the following check
boxes appear:
l

Save payment information lets you save payment information that you enter for this transaction and client
securely in the Sage Exchange Vault—not in your Sage 100 Contractor company files.
If you choose to store credit card or bank account information in the vault, you enter this information when
you process an electronic receipt for a client. This information is stored anonymously in the Sage Exchange
Vault along with a vault ID that is returned to Sage 100 Contractor.
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Only the vault ID is associated with the client record in Sage 100 Contractor. The next time you process an
electronic receipt for that client, Sage Exchange uses the vault ID to identify the last credit card or bank
account number used for the client, or you can enter a different credit card or bank account number.
l

l

Use last payment method is available if you processed a payment for the client previously. If you select
this option, Sage 100 Contractor sends a reference key to Sage Exchange so that you can reuse the client's
secure payment information from the Sage Exchange Vault.

The Options menu includes two new options:
l

Process and Post—to process the receipt electronically through Sage Payment Solutions, where it will be
deposited to your bank account, and post the transaction to your Sage 100 Contractor General Ledger.

l

Post—to post a transaction to your Sage 100 Contractor General Ledger that you entered directly through the
Sage Virtual Terminal or using another payment processing service.
When you use the Post option, a separate Electronic Receipt window appears, where you enter details
about the receipt, including the date, reference number, payer's name, the last four digits of the deposit
account number, and the type of credit card used. In the U.S. edition, you can also select ACH as the
payment type.

l

There are new Process and Post and Post buttons that perform the same functions as their counterparts on the
Options menu.

When you submit the electronic receipt to Sage Payment Solutions, a Sage Exchange integration window appears, where
you can proceed with payment (entering credit card or bank account information as needed), cancel the payment, or change
payment card details or banking information.

3-3-1 Cash Receipts
The 3-3 Cash Receipts window is now called 3-3-1 Cash Receipts, and the Cash Receipts report has also been renamed
accordingly.

11-2 Work Orders/Invoices/Credits
Fields that used to be labeled for credit card information in older versions have been renamed Reference 2, Reference 3,
and Ref Date.
IMPORTANT: If you have been using these fields to store credit card information in the past, we strongly
recommend that you remove that information from these fields.

1-3 Journal Transactions
The Options menu in the 1-3 Journal Transactions window includes a new View Electronic Receipt selection, which is
available when you display an electronic receipt.
When you click View Electronic Receipt, a separate Electronic Receipt window appears, where you can:
l

View the details that were posted with the electronic receipt in Sage 100 Contractor.

l

View details of voided or credited electronic receipts.

l

Print a hard copy of the receipt.

In the 1-3 Journal Transactions window, you can also void an electronic receipt that has not been settled in Sage
Exchange using the Void Transaction option on the Edit menu.
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NOTE: You can void an electronic receipt that has not been settled in Sage Exchange. If it has been settled and you
proceed to void the transaction in Sage 100 Contractor, the program will attempt to create a credit transaction in Sage
Exchange. If it cannot create the credit transaction, you must log on to Sage Exchange to correct the receipt
manually.

Drag Excel, Word, and other documents to the Desktop
When editing shortcuts, you can drag various types of documents, including Excel, Word, and PDF documents, and drop
them on the Sage 100 Contractor Desktop, where you can easily open them without minimizing Sage 100 Contractor.
To open a document in the associated program, you simply double-click its icon on the activity center desktop. You do not
have to leave Sage 100 Contractor to hunt for and open documents you use regularly for reference!
TIPS:
l

While you cannot drop URLs directly on the Desktop, you can copy a bookmark from your browser, save it as a
shortcut on your Windows desktop, and then drag the shortcut to the Sage 100 Contractor Desktop. You can
view the website in your default browser simply by double-clicking the shortcut.
Make sure you do not delete the shortcut from your Windows desktop, or the shortcut on the Sage 100
Contractor Desktop will not work.

l

You can also drag folders from Windows Explorer, and drop them on the Desktop.

l

As a best practice: On your Windows desktop, create a folder called "Sage 100 Contractor Shortcuts," and
then save shortcuts to that folder before dragging them to the Sage 100 Contractor desktop. Storing all your
Sage 100 Contractor shortcuts in one place will help you stay organized and may serve as a reminder not to
delete them.

NOTE: Similar to shortcuts you create for Sage 100 Contractor windows and reports, you must select Click here to
edit your shortcuts before you can drop documents on the Desktop. In edit mode, you can also rename the icons.
However, you cannot link icons for external documents to process flows.

Service Attachments
Sage 100 Contractor now accepts attachments sent with service work orders from third-party applications, and allows
third-party developers access to attachments that are included with Sage 100 Contractor work orders.
Documents and pictures sent as attachments are copied to a local Attachments folder (such as C:\mb7\'company
name'\Attachments\Clients\Service Invoices).
When you view work orders in the 11-2 Work Orders/Invoices/Credits window, you can open and view the attachments
as you would an attachment you added directly in Sage 100 Contractor.
Also, when you query work orders, the results include details for any attachments.

Reversing Payroll costs to a different period than the original
transaction
When posting a reversing entry for a voided payroll transaction to a different period than the original transaction, Sage 100
Contractor does not void the original job costs. Instead, the job costs are reversed in the same period as the payroll
reversal.
In this way, job costs always match the posted general ledger transactions, preserving the job-costs-to-general-ledger
balance.
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New Links to Customer Resources
We have updated the Customer Resources links on the Home and Resources tab.
p

p

p

For information about Sage 100 Contractor, you now click Customer Resources > MySage.
The Customer Resources > Contact Us link now takes you to a fresh, new web page that provides a variety of ways
for you to contact us
You will be able to enter enhancement requests for Sage 100 Contractor on a new web page when you click
Customer Resources > Product Enhancement Requests. See the next section for more information.

New Program for Product Enhancement Requests
Sage is replacing Ideascope with a new program, VersionOne, to collect your ideas for product enhancements. VersionOne
provides better capabilities for tracking activity on the ideas you submit, and it also provides improved voting options.
VersionOne will be the new destination when you click the Customer Resources > Product Enhancement Requests
link in Sage 100 Contractor version 19.3.
Before you can submit your ideas through VersionOne, you must register as a user. As part of the registration process, you
will receive an email message that contains a unique link, which you must click to confirm your email address. Once you
confirm your email address and you have been authorized to use a given forum, you can:
l

Browse ideas. You can browse by tab to view ideas sorted in various ways.

l

Comment on existing ideas. You can submit public comments to inject alternatives, examples, or other relevant
information .

l

Submit new ideas. Before you can submit an idea, the system requires you to check that the idea does not already
exist in the system, reducing potential duplication.

l

Vote. You can vote once for each item. By voting for a limited number of items, you can declare your top priorities.

l

Flag a submission as inappropriate. A product owner will review flagged ideas and comments. Submissions that the
product owner deems inappropriate are not displayed in VersionOne.

Ideas you submitted through Ideascope are already incorporated in our ideas database, so you do not need to re-enter
enhancements you requested before. However, if you would like to track activity on your ideas, you are welcome to re-enter
them in VersionOne.

Other enhancements in this version
Sage 100 Contractor Version 19.3 includes the following additional enhancements:
n

n

n

n

There is additional help for the 5-2-4 Payroll Checks window when printing check stubs for direct deposits. If an
employee is set up for emailing, you receive a message asking whether you want to email the deposit at this time. Now,
when you click the Help button, the program displays a topic that clarifies this choice and explains how you could email
the check stub later. We recommend that you click Yes to email the check when you print direct deposit checks.
The 5-2-2 Payroll Records window and the 5-5-1 Daily Payroll Entry window now warn you if you try to save a
timecard that uses a voided service order number.
When recalculating balances in the 1-6 Period/Fiscal Year Management window, the check for duplicate records runs
only once.
Vendor 1099 (or T5018) reports you print using the 4-1-1-61 Vendor List menu now show the 1099 (or T5018) total
amount from the ledger. Also, the report now includes a Tax ID column.
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n

n

Vendor 1099 (or T5018) reports you print using the 4-1-5-61 Vendor Payment Journal menu now include a Payment
Amount column, and you can filter the report by 1099 (or T5018) type.
The help topic "About setting up payroll calculations for paygroup benefit packages" now explains why you should not
use certain calculation methods. (Reports exclude benefits that use the 2-%Total Taxable Wages, 10-Per Day, 11-Per
Pay Period, 17-Tables, and 18-Variable calculation methods.)

Enhancements for the U.S. Edition
Sage 100 Contractor Version 19.3 includes the following enhancements to the U.S. Edition:

Additional U.S. State Certified Reports
Does your company perform work on government-funded construction projects?
Form WH-347 and state certified reports are available through our integration with Aatrix. Properly filled out, this form
satisfies the requirements of Regulations, Parts 3 and 5 (29 C.F.R., Subtitle A) as to weekly payrolls submitted in
connection with contracts subject to the Davis-Bacon and related Acts.
Besides the U.S. Federal report, which was available in Version 19.2, state certified reports are now available for the
following states (an asterisk indicates a new report for Version 19.3):
l

Alabama*

l

Alaska

l

Arizona*

l

Arkansas*

l

California

l

Colorado

l

Connecticut*

l

Delaware*

l

Florida*

l

Georgia

l

Hawaii*

l

Idaho*

l

Illinois

l

Indiana*

l

Iowa*

l

Kansas*

l

Kentucky*

l

Louisiana*

l

Maine*

l

Maryland*
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l

Massachusetts*

l

Michigan

l

Minnesota*

l

Mississippi*

l

Missouri*

l

Montana*

l

Nebraska *

l

Nevada*

l

New Hampshire*

l

New Jersey

l

New Mexico*

l

New York

l

North Carolina

l

North Dakota*

l

Ohio*

l

Oklahoma*

l

Oregon*

l

Pennsylvania

l

Rhode Island*

l

South Carolina*

l

South Dakota*

l

Tennessee*

l

Texas*

l

Utah*

l

Vermont*

l

Virginia*

l

West Virginia*

l

Wisconsin*

l

Wyoming*
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Fixes in Version 19.3
We have made the following software fixes in the first release of Version 19.3.
n

n

n

n

When you set the Phase field in the 4-2 Invoices window to skip during entry, the program correctly skips that field when
you enter an order number.
An ineffective option to save default settings no longer appears on grid-printing screens. The Defaults menu appears in
regular print windows, where you can save printing defaults.
When you print Job Contact List reports after deleting contact information in the 3-5 Jobs window, the long name for the
job no longer appears inappropriately at the top or the bottom of the report.
When you enter a paid Accounts Payable invoice that includes a job, if you click the Automatically job cost upon save
icon, you receive a reminder that paid entries will not be posted to the general ledger or to job costs.
NOTE: When you post a new invoice with a Paid status, you cannot automatically cost jobs or create
payments. Only the invoice entry is saved.

n

n

n

n

n

n

n

n

n

n

When entering recurring payables (in the 4-6 Recurring Payables window) or recurring receivables (in the 3-11
Recurring Receivables window) you are no longer required to enter discount terms or due terms.
When posting a large number of service contracts in the 11-2 Work Orders/Invoices/Credits window, you no longer
receive a message asking you to change their priority on the dispatch board.
In the 5-2-6 Post Payroll to GL window, if you reverse a payroll record rather than void it, the associated job and
equipment cost records are left intact to match the original GL transaction. When you post the reversal to the ledger a
new set of cost records is created to match the reversing transaction. This treatment maintains the balance between the
General Ledger and the Job Costs-To-General Ledger balance, even if the reversed record is posted to a different
period than the original record.
To prevent the truncation of attachment file names, Sage 100 Contractor now ensures that attachments use files names
no longer than 100 characters. Attachment descriptions can now use up to 100 characters, whereas previously they were
limited to 75 characters. Temporary backup files are now saved in the Sage 100 Contractor ProgramData folder.
When printing a consolidated financial report in the 2-8 Financial Reports window, you can select only companies that
have the specified reporting year and period.
In the 10-3 Schedules window, we have changed the Use Company Calendar during Calculation option to read Add
off days from company calendar to make the purpose of this option more clear. (The option functions the same as in
earlier versions.)
We have improved the performance of the 2-3 Income Statement report printing window when printing statements that
include subaccounts. It now takes significantly less time to print the 2-3-41, 2-3-51, 2-3-53, and 2-3-71 reports than in
Version 19.2.
The Archive Wizard (in the 1-6 Period and Fiscal year Management window) now updates the progress bar more
smoothly when removing data, indicating that the archive process is still running.
When you enter an invoice for a vendor that uses the 15th of the month as due terms, the 4-2 Accounts Payable
window now assigns the correct due date no matter which day of the month you enter the invoice.
Appointments you create for clients in the 3-6 Receivable Clients window are now properly saved to the calendar and
the client record. Any existing appointments are retained, and only appointments you delete are removed.
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n

n

You can now search by vendor name when you run queries in the 4-2 Payable Invoices/Credits window.
In the 9-5 Takeoffs window, you no longer receive an "Unhandled Exception" error message when you export change
orders by Job/Phase

n

We have restored the Save Current Grid View option in the 9-5 Takeoffs window.

n

Posting payroll to General Ledger is much faster than in Version 19.2.

n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

In the 5-2-1 Employees window, the Direct Deposit Rate Type is now saved correctly in new and existing employee
records.
Checks entered with a void status in the 1-1 Checks/Bank Charges window use the correct format for the posting
period and appear correctly on the check register.
When archiving a company that uses a LIFO or FIFO inventory method, the program now properly validates the archive
folder. Inventory balances for future years are not included in the archive.
The 2-2-31 Balance Sheet report now shows the correct Retained Earnings balance for the previous year after you
archive the previous year.
When you generate a 2-9-21 Statement of Cash Flows report in period 1 of a new year, the Increase in Equity amount
shown on the report is now correct.
In the 6-2 Budgets, 6-9 Proposals, and 6-10 Unitary Proposals windows, when you create a new proposal by
importing the budget from another job, the window displays the job for the new proposal.
When you customize Aatrix forms in the 5-3-9 HR Forms window, you can now edit text fields.
If your company name includes special characters (such as "&"), you can now email pay stubs when you generate
payroll checks for direct deposit in the 5-2-4 Payroll Checks report printing window. The program now inserts an
underscore in the PDF file name to prevent an error.
In the 1-9 Company Departments window, you can now save a new Service Receivables Type if the department uses
the same number as a dedicated account.
The 5-1-5-21 Workers Comp report no longer displays rounding differences in the overtime column.
Notes are now saved to the current company folder by default, although you can save notes to a different location when
you use the Save As function.
When you enter multiple receipts in the 4-7-3 Enter Credit Card Receipts window, the cursor now always moves to the
first empty field after you save.
In the 6-6-1 Purchase Orders window and the 9-5 Takeoffs window, when you select rows and columns in the grid, the
visual display shows your exact selection.
The 10-3 Schedules window now displays a message after you add days off to the company calendar and recalculate a
schedule.
You can include new calculated Vendor YTD and Fiscal Year fields in Accounts Payable reports and forms. You use
the Fiscal Year field to specify the year for which you are running the report. The Vendor YTD field calculates amounts for
that Fiscal Year.
In the 10-3 Schedules window, you can now move tasks correctly by one day or more days when you use the Grid/Gantt
view.
In the 10-3 Schedules window, you can now move tasks correctly in the Grid/Gantt view even if neither Saturday or
Sunday is marked as off.
In the 11-2 Work Orders/Invoices/Credits window, when you create queries that use the In List parameter to select
more than one client, the query results include all the specified clients.
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n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

n

Sage Construction Anywhere cost codes are now updated correctly when you change a budget cost code that included
only a material cost type to one that includes both material and labor.
The 1-4 Recurring Journal window now displays an error message if you try to post multiple recurring transactions
without entering a cutoff date. The Posting Cutoff Date field now includes an asterisk to indicate that it is required.
For 8-1-4 Equipment Management Reports, reports 22, 27, 32, and 37 that include period selection now properly
identify the year to which the selected period belongs.
In the 10-3 Schedules window, the Grid/Gantt Chart now refreshes correctly if you save days off changes to a job, and
then select a different job without first closing the 10-3 Schedules window.
In the 10-3 Scheduling window, the Scheduling Recap now displays jobs ending today.
If you use Windows 7 and Windows Server 2008 and your Windows Color 1 setting uses a dark color, text in highlighted
grid rows appears white, so the text is more legible against the dark background.
If you are running Sage 100 Contractor on a Terminal Server, you no longer receive an error message saying the error
"Sage 100 Contractor 2014 has stopped working' when you start the program.
In the 3-2 Receivable Invoices/Credits and the 4-2 Payable Invoices/Credits windows, when you select one or more
entire rows on the grid, and then you click a different cell, highlighting in the entire rows now disappears, as expected.
The 4-7-3 Enter Credit Card Receipts window now lets you save a default entry for the Credit Card field.
In the 6-4-1 Change Orders window, the Period of an approved change order does not change if you save an attachment
after advancing the period.
The 2-3-53 Dept Income Statement report now displays account names correctly.
Accounts Receivable invoices you post using third-party programs now consistently include in the associated journal
transaction all the detail lines from the invoices.
When you accept a default value in a cell by pressing the Enter key, the value is used only in that cell even if you had
highlighted several cells on the grid first.
Accounts Payable invoices that include freight costs for a WIP job now post correctly to the WIP cost account, rather
than the dedicated Direct Cost Account.
In the 12-4 Purchase Order Receipts window, Sage 100 Contractor now adds an extra row for sales tax when you save
a receipt with details that fill all the rows in the grid.
We have added additional checks to the job removal process to ensure that when you archive a year, or when you use
the 3-5 Jobs (Accounts Receivable) window to remove jobs, you do not inadvertently remove jobs that have job costs
in the current year. The archive process does not remove a closed or refused job unless the job has: a zero balance; no
open payable invoices/credits; no job costs in the current books; no payable invoices/credits in the current books (even if
they are paid or void); and no balance in a WIP account.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:
n

We have reformatted the EFT files so that they are consistently accepted by Canadian banks.

n

You can now run Aatrix reports for the Sample Company as if the company is registered with Aatrix.

n

n

The 5-1-4-21, 5-1-4-22, 5-1-4-31, and 5-1-4-32 reports now display information for an employee for whom EI, PPIP, or
QPP is not computed in the payroll record. If an employee has been paid wages or has paid tax in the province, they are
included on these reports.
In the 11-2 Work Orders/Invoices/Credits window, when you enter a paid amount for an invoice, the invoice balance for
the service receivables is reduced accordingly.
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n

n

n

n

n

Payables created from recurring invoices are now available for payment in the 4-3-1 Invoice Selection window.
When creating standard calculations in the 5-3-1 Payroll Calculation window, if you select the CPP check box, the
QPP and PPIP check boxes are automatically selected.
The 2-11-0-21 GST/HST report now includes credit card receipts that were entered without a vendor in the 4-7-3 Enter
Credit Card Receipts window. These transactions appear at the top of the ITC section for the period, sorted by
transactions date.
The 1-1 Cheques/Bank Charges Equipment Costs window now displays the correct title.
Income taxes are now calculated correctly for hourly records that use Tax Type 16-Alimony/Maint. Payments, 18-Union
Dues, and 19-Employee RPP Contributions.
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 19.3.

General
Internet Access Required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests, accessing Help, or
downloading periodic product or tax updates all require Internet access.
To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has
access to the Internet.
During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the
Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage
100 Contractor is installed, then disconnect the Sage license server from the Internet.
NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.
See "Appendix A: System Requirements" for supported browsers in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm.

Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100
Contractor. You can also use Sage Advisor Update to download updates for your Sage products.
TIP: Use the Customize settings in the Windows system tray to make sure you can view the Sage Advisor Update
icon and notifications from the System Tray in your Taskbar.
For more information about Sage Advisor Update, see "About Sage Advisor Update" in the User Guide and in the Sage 100
Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:
l

For updating forms and executable files.

l

For electronic filing (eFiling) of the forms.

Both of the operations listed can report an Internet connection problem. The vast majority of these problems are a result of
problems communicating through an Internet firewall.
Firewalls need to have access allowed through specific ports:
l

The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site http://updates.aatrix.com.

l

The eFiling component uses secure HTTPS on port to access the site https://efile.aatrix.com.
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By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow
access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.
For updating using http on port 80 to http://updates.aatrix.com:
l

aatrixforms.exe

l

updater.exe

l

updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:
l

builder.exe

l

viewer.exe

Locating tax updates
Tax updates are released throughout the year. To get the latest information about tax updates:
1. Log on to the Customer Portal, http://na.sage.com/us/sage-construction-and-real-estate.
2. In the Solve a common problem section, click Sage Contractor Downloads and Updates.

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4
1 3 26 AP Aging report for the prior year, the report shows a reduced Retention amount, and the amount paid in the future
period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was
paid.
Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that
reflect the true amount of retainage outstanding at year end.
TIP: If you archive your data at year end, you can also print the reports from the Archive, later.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card companies
as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security
weaknesses and threats.
A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to
process credit card payments and being audited and/or fined. (For more information about PCI standards, see
https://www.pcisecuritystandards.org/.)
Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to
seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program
uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check
and credit card transactions.
Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card
transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check
and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant
vault, protecting your from exposure to non-compliance penalties and credit card fraud.
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CAUTION: To avoid non-compliance with PCI standards, do not store credit card information in Sage 100
Contractor. Such storage also creates unnecessary risk for your business and your customers.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3.
Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.
IMPORTANT: To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your
Windows operating system. For more information about installing the Windows Fax Service component, see the Sage
100 Contractor Help topic, “Installing the Windows Fax Service component.”

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations
can potentially disable the communication:
l

File sharing on computers running the Windows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012
operating system must be enabled. To enable file sharing, follow the instructions in the Windows Help.

l

TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

l

Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2
Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8, Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard operating systems. If the
service stops, the program displays a message advising you to take further action to resolve this issue.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to
allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need to manually adjust some settings in the firewall in order to ensure proper operation.
You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.

To configure the Windows Firewall:
1. For Windows Vista or Server 2008, click Start > Control Panel > Security.
For Windows 7, click Start > Control Panel > System and Security
For Windows 8, click Start > All apps > Control Panel > System and Security.
2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.
3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selecting Add Program, then
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browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.
NOTE: By default, the exception is set to allow access by any computer on the network. You can refine this setting
by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to be
unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files\Sage\Sage 100 Contractor

l

C:\ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files\Sage\Sage 100 Contractor

l

C:\ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Sage\Sage 100 Contractor
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l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files\Sage\Sage 100 Contractor

l

C:\ProgramData\Aatrix Software

l

C:\Program Files\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Sage\Sage 100 Contractor

l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012
l

C:\MB7

l

C:\ProgramData\Sage\Sage 100 Contractor

l

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
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l

C:\Program Files (x86)\Aatrix Software

l

C:\ProgramData\Aatrix Software

l

C:\%LocalAppData%\Sage\Sage 100 Contractor

l

Network location of Sage 100 Contractor data

Configuring Windows Regional and Short Date Format:
1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region .
2. Click Region and Language.
3. On the Formats tab, select English (Canada)English (United States).
4. Under Date and time formats, from the Short date format drop-down list, select dd/MM/yyyy MM/dd/yyyy
5. Click [OK].
6. Close the Clock, Language, and Region window.

Windows 8 Professional and Server 2012 Standard Operating
Systems
Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents
computers from obtaining a license use
If a computer running the Windows 8 Professional or Server 2012 Standard operating system is used as a license server,
when it goes into sleep mode other computers on the network can’t obtain a license.
To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:
1. Start > All apps > Control Panel > System and Security > Power Options.
2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8 Professional or Windows 8 Enterprise operating systems. If the service stops, the program displays a message
advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer
running Windows Server 2012, follow these steps to resolve the issue:
1 On the Window desktop, right-click Start, and then click [Explore].
2 On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
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3 On the MB7 Properties window, click the [Security] tab.
4 From the list under Group or User Names, select USERS, then click the [Edit] button.
5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.
6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be
enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating
Systems
Launching Sage 100 Contractor to run as administrator for scheduling reports
IMPORTANT: On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “run as administrator” or to “run the program as administrator.”
Microsoft Windows has changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating
systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, you must
launch Sage 100 Contractor with the command to either Run as administrator or Run this program as an
administrator.
When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as
administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.
NOTE: "Run as administrator" and "Run this program as an administrator" are not related to Windows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are
running.

To set "Run as administrator":
1 On your Windows desktop, right-click the Sage 100 Contractor program icon.
2 From the drop-down menu, to launch the program, click [Run as administrator].
NOTE: Selecting Run as administrator only runs the current session of running Sage 100 Contractor. The setting
does not persist after the session is over.

To set "Run this program as an administrator":
1 On your Windows desktop, right-click the Sage 100 Contractor program icon.
2 From the drop-down menu, click [Properties].
3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.
4 Under Privileges Level, select Run this program as an administrator.
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5 Click [Apply], and then click [OK].
NOTE: Selecting Run this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard
"Sleep Mode" prevents computers from obtaining a license use
If a computer running the Windows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a
license server, when it goes into sleep mode other computers on the network can’t obtain a license.
Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:
1. Start > Control Panel > System and Security > Power Options.
2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.
If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation
continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click the Start button in the lower left corner of the display.
2 Highlight Administrative Tools and select Server Manager.
3 In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In the Server Manager interface, select Add Features to display a list of possible features.
2 In the Select Features interface, expand .NET Framework 3.5.1 Features.
3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.
4 In the Confirm Installation Selections interface, review the selections and then click [Install].
5 Allow the installation process to complete and then click [Close].
NOTE: Enabling .NET Framework 3.5.1 may require a reboot.
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Solution for Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server
2008 R2 operating system, follow these instructions:
1 On the Window desktop, right-click Start, and then click Open Windows Explorer.
2 On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3 On the MB7 Properties window, click the Security tab.
4 From the list under Group or User Names, select USERS, and then click the Edit button.
5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
6 Selecting Full control selects all the check boxes necessary for this solution.
7 On the Permissions window, click OK, and then on the MB7 Properties window, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operating Windows 2008 Server R2, you may experience the following error
message when trying to open a photograph or image file in Sage 100 Contractor:
"No application is associated with the specific file associated with this application."
This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled
the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install Desktop Experience
using the Server Manager utility:
1 In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2 In the Server Manager window, click Features (left-hand pane).
3 In the Features pane, click Add Features.
4 Select the Desktop Experience check box.
5 If you are prompted to add additional features, click [Add Required Features].
6 Click [Next].
7 Click [Install].

Windows Vista and Server 2008 Operating Systems
Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server
2008 operating system, follow these instructions:
1 On the Window desktop, right-click Start, and then click [Explore].
2 On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.
3 On the MB7 Properties window, click the Security tab.
4 From the list under Group or User Names, select USERS, then click the [Edit] button.
5 On the Permissions window, select USERS again, and under Allow, select the Full control check box. Selecting Full
control selects all the check boxes necessary for this solution.
6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].
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Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes into Sleep Mode, the workstations
cannot obtain a license use.
Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008.
Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to "Never":
1 Start > Control Panel > System and Maintenance > Power Options.
2 Select Change when computer sleeps.
3 From the Put computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License Server
computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the command may fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-bit
operating system
On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may encounter a
conflict with the Microsoft print spooler (splwow.exe) and may not function as expected.
A solution for avoiding this possible conflict would be to schedule reports on computers running a 32-bit operating system.
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